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Chapter – 4 

ADOBE PHOTO SHOP CC 

Introduction: 

Adobe PhotoShop 7.0 is a powerful tool for creating, editing, manipulating and 

maintaining images both for the web and in the printed medium. It can be used to 

create spectacular graphics for a web site, or to enhance digital photographs for vital 

presentations. Whether you’re maintaining a personal website or editing images on 

behalf of your department, a good basic knowledge of PhotoShop can help you on 

your way to a professional level of graphic design and implementation in your work. 

 

This course will be broken down into four main areas: 

1. Introduction to the Work Area: - a look at the various tools, toolbars, palettes 

and menus that you will use in Photoshop 

2. Creating Simple Graphics: - Learn how to create banners, logos and buttons 

for the web and presentations 

3. Digital Image Manipulation: - Learn how to manipulate digital photographs 

with such techniques as Red Eye removal and other more complex image 

manipulation practices 

4. Web Site Composites: - Learn how to create the look and feel of a complete 

web site, cutting the graphics to fit the web page and other issues 

involved with producing graphics for use on the web 

 

There is, of course, a lot more to Adobe Photoshop than can be covered in this 

course. The comprehensive help file that comes with Photoshop can help a user to 

find information on aspects not covered in this manual, and there is a wide variety of 

online tutorials available, with the best obtained through www.adobe.com. The time 

constraints of this course should not, however, preclude the achievement of a good 

solid grounding in the basics of Photoshop, sufficient to the everyday graphics needs 

of most departments. As always, we hope you enjoy the course and encourage 

questions and feedback throughout the day. 

http://www.adobe.com/
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1. Introduction to the Work Area: 
In this section we will look at the tools, palettes, menus and work area of Photoshop. 

We will go through the main tools, looking at what each one does. We will then go 

through the menus, identifying the functions contained within each one. Then we will 

look at the different toolbars and palettes that give Photoshop its great functionality. 

 

The Tool Palette: 

To the right we have the tool palette. This contains the tools you 

need for image creating, editing and manipulation. The tools with 

black arrows at the bottom right corner indicate that there are 

more options within that tool. To access the other tools within that 

tool, just left click the mouse and hold it down. The currently 

selected tool is the move tool. Hovering the cursor over the tool 

will give you its name and the keyboard shortcut to access it (in 

the case of the move tool Shift + M will automatically select it for 

you). 

The tools in the top four sections of the tool palette are as follows 

(moving anticlockwise): 

• Marquee: this tool allows you to select an area of an 

image within a particular shape. The default is rectangle, 

but there is also an ellipse selection as well as a single row 

and single column marquee 

• Lasso: this tool allows you to select irregular areas of an 

image. In the image to the right, the polygonal lasso tool 

is showing. There is also the freehand lasso tool and the 

magnetic lasso tool (which will find the edge of an 

element within the image you are trying to select). 

• Crop: this tool allows you to cut an image to a particular 

segment. 

• Healing Brush: this tool allows you correct imperfections, 

 

 

Figure 1.1 
causing them to disappear into the surrounding image. You use the 

healing brush tool to paint with sampled pixels from an image or pattern. 

The other 
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tool that this button allows you to select is the patch tool. The patch tool lets 

you repair a selected area with pixels from another area or a pattern. 

• Clone Stamp: this tool takes a sample of an image, which you can then apply 

over another image or part of the same image. Each stroke of the tool paints 

on more of the sample. The other tool that can be selected here is the pattern 

stamp tool, which lets you paint with a pattern. You can select a pattern from 

the pattern libraries or create your own patterns. 

• Eraser: this tool allows you to erase parts of your image. You can also select 

the background eraser tool or magic eraser tool which allow you to erase 

specific parts of the image. 

• Smudge: this tool allows you to create an effect similar to the effect caused 

when working with pencils and you smudge an area of the image with your 

finger. The companion tools to this tool are the blur tool and the sharpen 

tool which allow you to blur the focus or sharpen the focus of an area of the 

image 

• Path Selection: used for selecting vector images. Vector images are images 

that can be resized without loosing resolution because they are based on 

mathematical formula as opposed to bitmapped or raster images, which are 

constructed using a finite number of pixels. The companion tool to this is the 

direct selection tool, which allows you select a path segment. 

• Pen: used for creating straight lines and smooth curves with precision. The 

image created is a vector image. There are a number of companion tools to 

this tool – freeform pen, add anchor point, delete anchor point and convert 

point tools 

• Notes: this tool is used to add notes to an image. They are not part of 

the image but can be useful when sharing the image as the image author can 

add valuable information about the image to the image file so others can 

appreciate what is intended by an image. The companion tool to this tool is 

the audio annotation tool, which allows a user with a microphone attached 

to their computer to add a “speaker note” to the image to convey 

information to other users of the image. 

• Hand: allows you to move an image around the screen to allow access to 
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various parts of the image when the image is too big for the screen 
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• Zoom: allows you to magnify/de-magnify areas of an image to allow for more 

detailed work 

• Eyedropper: this tool allows you to set the colour of the foreground of the 

colour palette from a colour within the image. The companion tools are the 

colour sampler tool and the measure tool, which can be used to get the exact 

coordinates and pixel height and width of any part of the image 

• Rectangle: this tool allows you to draw different shapes, 

with the default set to rectangle. You can also draw 

rounded rectangles, ellipses, polygons, lines and custom 

shapes. 

• Text: this tool allows you to add text to your image. You 

can also change the orientation of text to the vertical type 

tool. 

• Sponge: this tool allows you to subtly change the colour of 

the image, by altering the colour saturation of the area 

adjusted by the sponge tool. The other options under this 

tool are the dodge and burn tools, which are used to 

lighten or darken an area of the image respectively. 

• Gradient: a gradient allows you to fill an area of an image 

with a colour range, where the colours gradually run into 

each other. The other option with this tool is the paint 

bucket or fill tool, which you would use to fill a selected 

area of the image with a single colour. 

• History Brush: this tool allows you paint with the source 

data from a specified history state or snapshot. The other 

option is the art history brush which allows for painting 

with stylized strokes from a specified history state or 

snapshot 

• Paint Brush: this tool is as you would imagine used to 
Fig1.1b 

paint on an image. There are numerous different brush shapes and sizes 

that 

allow the user to create different textures to their image. The other option 
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to this tool is the pencil tool. 
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• Slice: the slice tool allows you to divide an image into sections, making it 

easier to break up the image for putting it on the web or for making 

composite images. The second option under the slice tool is the slice select 

tool, which allows you to apply modifications to a slice that you have created. 

• Magic Wand: the magic wand tool is another tool that you can use to select 

an area on the screen. It is used when you want to select an area that 

contains the same colour throughout. 

 

Tool Options: 

As you can see there are a wide variety of tools to be used. Each tool also comes 

with it’s own set of tool options. These options allow the user to fine tune aspects of 

the tools usage and are different for each tool in question. 

 

Fig 1.2 

In Fig. 1.2, we see the tool options for the text tool. The first item in the tool options 

palette is the tool presets button that allows you to access preset combinations of 

options, which you may have saved in the past. This feature allows for you to save 

common combinations of options so that you do not have to reset them every time 

you use the tool. 

In the text tool options, the next button allows you to change the orientation of 

the text. Following that we have the options to change the font and the font style. 

Next, we have the drop down list to change the font size, while the types of anti-

aliasing you want to set follow this. Anti-Aliasing is a technique where by extra pixels 

are added at the edges of shapes in order to give them a smoother, less 

pixelated look. The alignment buttons and the colour swatch for choosing the colour 

of your text in turn follow this. The second last button on the tool options palette 

allows you to create warped text while the final button allows you to open up a 

dialogue box for further character and paragraph options. As we have said, these 

are just the text tool options – as we use different tools, we will see their different 

options in use. 
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Menus: 

We can also see the menu bar in Fig. 1.2, showing the different menus that the 

user can choose from. Each of these contains a drop down list of even more options: 

• The file menu enables the user to perform operations such as open, close or 

save. Indeed, there are even a number of different save options to enable the 

user to save the image in the most appropriate context. 

• The edit menu offers a range of options for editing the image. One of the 

most popular features that we will use from this menu is the transform 

option, which allows us to scale, rotate or skew and image element. 

• The image menu gives options for working with the image such as resizing 

the amount of pixels in the image, or increasing the size of the work area or 

canvas. 

• In PhotoShop, images are contained on layers. The advantage of this is that 

we can compose a more complex graphic from independent graphic elements 

based on separate layers. Each layer can be edited separately without 

compromising the overall integrity of the image file. To this end we have a 

layers menu for performing operations to do with the management of the 

different layers within an image. 

• The next menu along the menu bar is the select menu, which allows you to 

perform operations on selections. 

• Next to the select menu is the filter menu. This menu provides the user with 

many different filters that they can apply to their image to create different 

effects. 

• The view menu allows you to such things as set a colour set for the 

document, turn on rulers, zoom in and out etc. 

• Second to last we have the window menu, which allows you to turn on and 

off the different palettes that we will use in the course of our work with 

Photoshop. 

• The last menu on the menu bar is the help menu. This is quite a 

comprehensive feature, due to the complex nature of the Photoshop 

package. As it will be impossible to demonstrate every single aspect of 

Photoshop’s 



Adobe PhotoShop 7.0 

Computer Training Centre, UCC 

9 

 

 

functionality, this feature will be a 

positive aid to you in your work with 

Photoshop after today. 

 

Palettes: 

In the work area there are a number of 

palettes visible to the user. These palettes 

contain useful functions for manipulating 

images. A complete list of palettes and the 

option to turn them on or off is visible under 

the window menu. 

Each palette can be made visible by clicking 

the tab with its name on it. The most important 

palettes are: 

• The History palette, which allows you 

to view the history of actions that you 

have performed on an image and to 

undo those actions while also 

providing you with the opportunity to 

save these actions for repeated use. 

• The Layers palette, which allows you 

to efficiently manage the different 

layers in your image. From here, you 

can lock a layer so that it can’t be 

edited, add image effects, create and 

delete layers, set the opacity of a layer 

and many other things that help you to 

create images cleanly and efficiently 

• The colour, styles and brushes palettes are also two very important palettes, 

giving you continued variety when creating and manipulating images. 

Individual palettes will be discussed as we meet them in the course of this class. 

Fig 1.3 
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2. Creating Simple Graphics: 
Now that we have looked at the workspace we will begin to create simple graphics. 

We will learn to use some of the more common tools and palettes to create some 

simple banners, logos and buttons for use on both web sites and in presentations. 

When it comes to these types of graphics it is quite often the best practice to keep 

things as simple as possible, only using a few colours, and keeping designs basic. 

 

Creating a Logo: 

We will start by creating a simple logo. Let’s say the company Discover Ireland have 

asked us to come up with a new corporate logo for them that will be used on their 

website and in promotional literature. It must identify the company at a glance, giving 

some impression as to what the company stands for. To that end, the simple 

combination of the outline map of Ireland, the initials “D I” and a magnifying glass 

should convey what it is we want. 

 
To begin we must open a new image. From the File menu, go to New (ctrl+N). We 

are then presented with the New Image dialog box (Fig. 2.1), which allows us to 

set 

certain properties 

of the image 

before we begin 

editing. For this 

image we are 

going to go with a 

custom size, 

which will allow us 

to set the width 

and height 

according to our 

own needs. In this 

case we will set 

the dimensions to 300 pixels wide by 300 pixels high, which should give us plenty of 

room to design our logo. We can, of course crop the image at a later stage (or 

indeed 

Fig 2.1 
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increase the canvas size should the need arise). We leave the resolution at 72 pixels 

per inch, as this is the default resolution for graphics to be used on the web. When 

creating an image for print, it is recommended that the image be 300 pixels per 

inch. Leave the mode set to RGB (stands for Red, Green, Blue) and the contents set 

to transparent. You can always add a filled layer later for your background when you 

know what it’s going to be. 

 

Fig 2.2 shows your workspace after launching the new image. We start by renaming 

our initial layer to background. It is always a good idea to give the different layers 

meaningful names so that you know what 

elements of the image each layer contains. To 

rename the layer, double-click the name of the 

layer and change the name to background, as 

seen in Fig 2.3. We will rename additional 

layers as and when we add them. 

Next we will create a new layer to contain our 

map of Ireland. The new layer button is circled 

in Fig. 2.3. Rename the layer Ireland. Next, we 

Fig 2.2 

Fig 2.3 
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will select a colour for the line that we will paint. To do this we double click on the 

foreground colour to launch the colour picker dialog box (Fig 2.4). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The colour we want is some kind of green. A nice Irish green has a hexadecimal 

RGB value of 339933*. Next we select the brush tool in order to begin our image and 

from the brushes palette we select an appropriate brush size and shape. For our 

purposes, 

the third brush down will be 

sufficient, but be aware of the other 

brushes available. Making sure that 

the Ireland layer is selected, begin 

your drawing. 

 

*: Colour of course is something that is quite 

subjective and up to you to decide whether or 

not it suits your purposes. There is significant 

talk of colour theory on the web and although 

it is out of the scope of this course, it is highly 

recommended that you familiarise yourself 

with some of the concepts involved so that you 

pick colours that complement each other in 

order to create the most visually appealing 

images. Some good sites include: 

www.lynda.com, www.colormatters.com 

Colour Value Foregroun

d Colour 

Brush Tool 

Fig 2.4 

Fig 2.5 

http://www.lynda.com/
http://www.colormatters.com/
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Fig 2.7 

 
You should end up with something similar to Fig 2.6. Next we will use the paint 

bucket tool 

to fill   the 

outline   with 

green. When 

you select 

the Paint 

 bucket 

tool,   

 make 

sure the tool 

options 

setting are 

as seen  in 

  Fig 

2.7. This will 

give you a 

solid         fill 

colour and yet will leave a gap between the outline and the block of green fill. 
 

Once you have filled the outline, it would be a good idea to save your image. For the 

time being we will save it as a Photoshop Document (.psd file extension) but we may 

save it later as a JPEG or a GIF, depending on our needs. To save the document, go 

to File> Save and in the Save dialog box, change the filename from untitled to 

DiscoverIreland_Logo and select the folder PSImages from the desktop in which to 

save the file. Make sure the Layers option is checked in the Save Options section 

so that you retain the layers and their associated information. When you are ready 

click Save and the file will be saved to the folder you specified. It is important to save 

your files regularly, especially when working with complicated image files, as you do 

not want to lose any changes you may have made in a particular session. 

Fig 2.6 

Paint bucket tool 
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Next, we will create another layer, this time to contain the magnifying glass part 

of the image. Rename it magnifying glass and select the Rectangular Marquee 

tool. 

We want a circular or 

elliptical shape so we hold 

the mouse key down on 

the 

rectangular marquee so that we are 

presented with the other options and then we choose the Elliptical Marquee Tool so 

that we can draw a circular shape on our image. When we have the circle drawn to 

our liking (so that it covers most of the Ireland shape) we must then fill this selection 

with 

a colour using the Paint Bucket tool as we did 

earlier. In this case we have chosen an orange 

colour to stay with the Irish theme. The colour 

code for this orange is FF9933. 

With the orange circle still selected, we copy the 

layer press ctrl + c and ctrl + v to paste (or 

alternatively click and drag the active layer 

down as far as the new layer button within the 

layer palette). Our new layer should be called 

magnifying glass copy and we will use this 

layer to create a smaller circle and then in 

turn 

use that circle to delete an equal area from the original magnifying glass layer so that 

we can see through the shape. 

To begin this process, we will change the colour of the copied shape to white by 

filling the still-selected shape with the paint bucket. Then we go to Edit menu and 

select the Transform sub-menu. From this we select the scale option, which will add 

a frame around our selected circle with which we can scale the image down in size. 

To 

scale, place the cursor over the top left hand corner 

handle of the frame and while holding the shift key, drag 

the circle to 85% of its original size – you can see the 

percentage of the original displayed within the tool 

options towards the top of your screen. Holding the shift 

Fig 2.9 

Fig 2.10 
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key maintains the proportion between the height 

and 
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width so that you have the same shape as the original, just smaller. We then move 

this second circle so that its centre point is aligned as close as possible to the centre 

of the larger circle giving us the image as seen in Fig 2.10. 

We must also commit transform by pressing the ‘tick’ in the tool options bar. You 

will be unable to make any further edits until you have done this. If at any time you 

wish to cancel the transform, you click the ‘cancel’ button next to the tick. 

Next, we will merge the two magnifying glass layers. This is achieved 

by first of all linking the two layers involved and then merging the 

linked layers. 

To link the two layers, we use the layer palette – simply click the empty square 

beside the eye icon on the inactive layer that you want linked. A little chain link will 

appear indicating that that layer is linked to the currently active layer. Make sure that 

it is one of the magnifying glass layers that is active and that it is the other magnifying 

glass layer that the chain appears in, otherwise when you go to merge the layers, 

you will 

have a problem. 

When you have linked the layers, go to 

the Layer menu and then down to 

Merge Linked (ctrl + E). The two 

layers have now become one layer 

called magnifying glass copy. If the 

white circle has become deselected, we 

can use the magic wand tool 

to select the white area. 

Once the white area has been selected, press delete on your keyboard to remove 

this area. Then press ctrl + D to deselect any selected areas. 

Next we will create a new layer called magnifying glass handle using the pencil tool 

from the tool palette. It is one of the options under the brush tool. Making sure 

the 

foreground colour is still set to orange set the brush size 

for the pencil to 13pts. Then click once at the edge of the 

orange circle. Move the cursor to an approximate angle 

of 

45 degrees and about 2 inches distant from the edge of the circle and hold the shift 

key while clicking once with your mouse. This will automatically draw a straight line 

Fig 2.12 
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from your first dot to the 2nd point. Merge the Handle layer and the rest of the 
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magnifying glass. We will now apply a style to this layer to give the magnifying glass a 

3-D look about it. 

In the layers palette, with the magnifying glass layer active, click on the layer style 

button. It is the button that looks like a little “f”. This will then bring up a list of style 

types that you can apply to your layer. From this list choose bevel and emboss… 

This will bring up the layer style dialogue box that will present you with a number of 

options for changing the characteristics of the styles: 

 

Depending on the effect you want to achieve, these options can be changed from 

their default setting allowing you to create a wide variety of interesting styles and 

graphics. 

In this instance though, we will maintain the 

settings as seen in Fig 2.15 by clicking OK. This 

will give us the style as seen in Fig 2.16 below. 

We will now add the initial D.I. (as in Discover 

Ireland) on a separate layer so that they can be 

“seen” through the magnifying glass. 

First, change the foreground colour to white and 

then select the writing tool (it looks like a capital 

T) from the tool palette and click in the middle of the magnifying glass. This will 

Fig 2.15 

Fig 2.16 
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automatically create a text layer for you and give you a prompt to start typing. Type 

the letters “D” and “I”. Next we will use the tool options to change the font and size 

of the text. Making sure that you are 

still using the text tool, select the text. 

Then in the tool options at the top of 

the screen, change the font to Book 

Antiqua and the size to 72 pts. Set the 

font style to bold. Next you should 

click and drag the text layer in the 

layer palette to below the magnifying 

glass so that the text appears below 

where the “lens” will be in the image. 

You will also notice that Photoshop 

will automatically name any text layers 

with their content so that you know exactly which layer you are dealing with. 

With the text layer active, we will now add a style to this layer. Again, within the layer 

palette click the style button and this time select Drop Shadow… This will put 

a shadow behind the 

text to make it look 

like it is floating 

above the map of 

Ireland. 

Again we are going 

to leave the settings 

as they are, but be 

aware that you have 

a good many options 

to play  around with 

here. It is worth noting the Use Global Light check box. If you keep this checked 

every time you add a style to any layer, then your image will look like the “light” is 

coming from only one direction. If you uncheck it for different layers and styles, the 

light source will seem to be coming from a multitude of different directions. Again, 

Fig 2.17 

Fig 2.18 
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Fig 2.20 

depending on what you want to achieve from your image, it may be a good idea 

to keep the global light source to promote uniformity and consistency within the 

image. The final part of the image that we are going to add is a layer that will 

contain the “lens” of the magnifying glass. We add this layer between the text 

layer and the magnifying glass layer and we’ll call it Lens. 

Make the magnifying glass layer active and select 

the magic wand tool. Click in the centre of the 

magnifying glass to select a circular shape. Then 

make the Lens layer active again. Select a 

light 

blue colour as your foreground colour. In this case we will use the colour code 

#3399CC to fill the selected area in the Lens layer. To fill the area use the 

paint bucket tool as before. The contents of the text layer should now be obscured. 

Next we will add a “reflected light source” to the lens. This is achieved simply by 

using a large brush with a white foreground colour. Select the brush tool and set the 

brush size to 45. Make sure the Air Brush option is selected in the tool options. 

 
 
 

 

Then in the top left of the image in the Lens layer, click the mouse once or twice to 

add the white “shine” to the blue “lens”. 

As we still cannot see the content of the text layer, we must reduce the opacity (the 

extent to which the content of the layer is visible) of the Lens layer so that the 

contents of the layers beneath show through. In 

the layer palette, there is a facility for reducing 

or increasing the opacity of the layer, which is by default set to 100%. We want to 

knock the opacity of the Lens layer down to about 55%. 

All that remains to be done is to crop the image so that there is not 

so much wasted space. Select the crop tool from the tool palette and 

select 

an area around the logo that is neat and that does not contain so much unused 

space. To crop, just click the accept button in the tool options, just as you did when 

you wanted to accept the transformation of an object. You should then end up with 

an image that is approximately 186 pixels wide and 218 pixels high (to check the 

size of 

Fig 2.19 
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Fig 2.24 

the image, go to the Image menu and then down to Image Size). You should end 

up with an image similar to the one in Fig 2.23 below: 

 
 

 

 
The last thing that remains for us to do is to save the image in a format appropriate 

to its usage. Photoshop supports most image formats for a variety of functions. 

When 

 

Fig 2.23 
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saving images for the web it is most common to save them as a .GIF or .JPG, where 

the former is used for graphics such as logos with simple colours and shapes. The 

latter is used where the image may contain complex images with millions of colours 

such as more detailed graphics or photographs. The Save For Web function under 

the File menu will save the image as a .gif. GIF stands for Graphics Interchange 

Format, and images in this format are optimised for image size and download time. 

They can also preserve transparency (which we have in this image for our 

background). We will save this image for the web now. When you do save for web 

you are presented with a dialogue box (see Fig 2.24), which will give you important 

information as to the size of the image and the download time of the image at modem 

speeds. This will give you an idea as to how quickly users of your website will be able 

to see the image. Leaving the default settings unchanged, we will choose the 

optimised version, which will be the one with the black border around it. Click the 

save button and then when the second save dialogue box presents itself, save to the 

PSImages folder on the desktop, without changing any of the other default settings. 

Our final image is presented below: 
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Fig 2.26 

Creating Banners: 

In this next section, we will look at creating a banner to advertise our Discover 

Ireland website. This image will be longer than it is wide so that it will fit onto a 

standard web page. It will also incorporate the logo we created in the last section 

along with some text and further graphical effects. 

 

To begin, we open a new image (ctrl + N). In the new image dialogue box, name the 

image DiscoverIreland_Banner and set the dimensions to 600 pixels wide and 100 

pixels high. Rename your first layer, Layer 1 to background. 

Next we want to copy the Discover Ireland logo into this new image. Start by opening 

the gif version of the logo (ctrl + O and then browse to the location of the File – the 

folder called PSImages on your desktop) and selecting the whole image (ctrl + A). 

Once the image has been selected, copy it (ctrl + c) and then switch to the new 

image. Next we need to create a new layer and call it logo and then paste the logo 

into this layer (ctrl + v). You will end up with the logo, partially displayed, 

because its 

dimensions differ from the banner (Fig 2.26). We will now reduce the size of the logo 

using the Transform function under the Edit menu, as we did in the previous 

section. We use the scale function within the transform sub menu. You may need to 

resize the image window in order to see all the transform handles around the logo. 

Once you can see all the transform handles, hold down the shift key (this maintains 

the ratio between the height and width of the newly scaled image) and drag the 

bottom right 

hand handle 

until the image 

fits into the 

canvas. Once 

you have 

Fig 2.27 
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done 

this, accept the transformation and move the logo to the left hand side of the canvas. 
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Next, we are going to add some text to the banner. Using the DI that is already there, 

we want to have the slogan “Dive into the myth…” on our banner. To do this we 

select the text tool. Set the font to Book Antiqua, the font size to 36pts, the font 

style to bold and the font colour to the same green as Ireland in the logo (#339933). 

Then click the cursor next to the Logo so that it will line up with the DI and type “ve 

into the myth…” When you have this typed you may need to move the text around so 

that you have it as close as possible to looking like the whole line has been typed out 

so that it reads “DIve into the myth…” (See Fig 2.28). 

 

The next thing we shall add to the image is a green ellipse to cover most of the right 

hand side of the image. We will then move the ellipse below the writing and change 

the colour of some of the text so that it is readable against it. 

The first step involved is to select the shape tool and choose ellipse from 

the shape options. Making sure green is our foreground colour, draw a 

large 

ellipse so that it obscure most of the right hand side of the image up to the “O” in 

“into” (you may need to use the transform - scale function to get the right shape). The 

layer created will be a vector mask shape. To add effects and styles to this shape 

later on, it must be in a bitmapped or rasterized format. To convert from a vector 

layer to a raster layer, make sure the layer is active and right click on the layer in the 

layer palette. From the menu presented, choose rasterize layer. Once you’ve done 

this, rename the layer to green oval and move it below the text layer by clicking and 

dragging in the layer palette. 

 

Next, we will select the text in the text layer from the “O” in “into” to the end of the 

slogan using the text tool. Of course, the Text layer must be active to do this. Once 

selected, change the colour of the selected text to white (#ffffff). At this stage we will 

Fig 2.30 

Fig 2.28 
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fill the background layer with the colour white as well. Make the background layer 

active and use the paint bucket tool to fill the entire layer, making sure the 

foreground fill colour is set to white. When this is done we end up with an image 

similar to Fig 2.31 below. 

 

Our next step will be to add a drop shadow style effect to the text, green oval and 

logo layers. For each layer in turn, click on the style button in the layer palette and 

select drop shadow from the list of styles. Within the drop shadow options, change 

the angle of the light source to 45 degrees. We end up with the image below. 

 

Next we will add some text to tell the viewers of our banner where to go to see the 

website. We select the text tool and click to add the web address: 

www.discoverireland.com to the bottom right hand corner of the image. Make sure 

this new text layer is at the top of the layer order in the layer palette. Reduce the font 

size to 14 pts but retain the other text settings. Also note that if you are having 

difficulty clicking and dragging the layers contents in order to position them, you can 

always use the arrow keys on the keyboard for more precise positioning. 

The final part of our image will be a light pattern going in a wave motion from left to 

right. To achieve this, there are a number of steps we must carry out first. Start by 

creating a new layer called pattern above the logo layer but below the text layers. 

Select the brush tool and then select the brushes palette. From the brushes palette, 

we will load an extra set of brushes, which will contain the brush pattern we want. 

Click on the arrow next to the title of the brushes palette and then choose Load 

Brushes from the presented menu (Fig 2.33). The Load brushes dialogue box will 

then appear, from which you should load the Special Effects brushes (Fig 2.34). 

We then choose 

Fig 2.32 

Fig 2.31 

http://www.discoverireland.com/


Adobe PhotoShop 7.0 

Computer Training Centre, UCC 

27 

 

 

Fig 2.36 

the brush we want which will be the brush shape that will give us spiral/concentric 

circles as we brush (Fig 2.35). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Leave the other brush settings as 

they are. 

Starting from the left, with green as 

you foreground colour, click and 

draw a wave/crest, stopping when 

you get to the edge of the green 

oval. Change the foreground colour 

to    white    and    continue    your 

undulating waves. To finish the step, knock the opacity for the pattern layer down to 

15% giving you an image similar to the one in Fig 2.36 

 

Our last step is to save the image in a format that is appropriate to its usage. This 

time, instead of using the save for web function (which is an equally valid option) 

we will 

Fig 2.34 

Fig 2.33 

Fig 2.35 
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save the image as a .jpg file type (JPEG stands for Joint Photographic Experts 

Group). A jpeg image is commonly used to display photographic or other continuous 

tone images on the web. It supports most colour modes and compresses images by 

selectively discarding data from the file in order to save on size. In Photoshop you 

can specify the level of compression and hence the size of the image when saving as 

a jpeg image. When a jpeg image is opened it is automatically decompressed. 

However, the more an image was compressed to begin with, the lower the image 

quality. Of course the level of compression used is purely up to you, depending on 

your priorities (e.g. do you want the image to download fast, but not of good quality or 

do you want the user to see the image in it’s full glory but have them wait a while) but 

remember, web users will not wait for more than a few seconds before they get bored 

and go look somewhere else for an appropriate image. 

So, to save our Discover Ireland banner as 

a jpeg (the image should already be saved 

as a 

.psd file as you have been working along), 

we select the save as… function from the 

File menu. From the save as dialogue box, 

choose .jpg from the format drop down list. 

When saving a jpeg, Photoshop will 

automatically add the word copy to the file 

name.   You   can   of   course   change   

this 

yourself later. Click the save button and you will be presented with the compression 

options (Fig 2.37). We want maximum quality for this image so set the quality to 12. 

You will notice that the slider is now at Large file because we are using minimum 

compression. In Format Options select Baseline (“Standard”) for a standard 

formatting. You will also notice that this dialogue box shows you the image size and 

how fast it will download at given transfer rates. When you’re happy press OK. Your 

image has now been saved as a Jpeg and should look like the image below: 

 

Fig 2.38 

Fig 2.37 
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3. Digital Image Manipulation: 
In this next chapter, we will look at manipulating digital images. We will be using 

digital photographs and manipulating them to suit our purposes. We will look at 

removing red-eye from photographs, removing parts of photographs and replacing 

them with other parts of the photo and brightening dark images to make the contents 

more visible. 

 

Removing Red Eye: 

In this section we will look at removing redeye from a photograph. In your PSImages 

folder on the desktop, there is a file called redeye.jpg. Copy this file and rename the 

copy redeye_example.jpg (it is always a good idea to have a clean back up copy of 

your original digital image or photo so you can start again should you make any 

mistakes during the editing). Next, open the file in Photoshop. You will notice the 

retinas of the man in this photograph are reflecting the flash of the camera causing 

what is known as red eye. We want to remove this, in what is a relatively simple 

procedure. 

It is a good idea to make a copy of the layer and work with this copy for the same 

reasons as you work from a copy of the original image – it is safer and there is 

less 

chance of you deleting your image 

completely. 

Once you have copied the layer, zoom 

in to 200% so that you have a better 

view of the eye area. 

After this, we create a new layer called 

redeye fill. This layer will contain the 

colour that will replace the red in the 

pupil of the eye. We use a separate 

layer, again, as a precaution. You can 

never be too careful in using separate 

layers so that you don’t completely 

destroy the original image. 

Fig 3.1 
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Next, select the magic wand tool. We will use this to select areas of red within the 

eye and then fill them with black. Make sure your background copy layer is active to 

select the red areas. 

 

Make the redeye fill layer active and select the paint bucket tool. Change the 

foreground colour to black (#000000) and fill the selected area. Press ctrl + d to 

deselect the selected area. You will notice that the majority of the red area is 

now filled with black. However, there are still some noticeable red areas that need to 

be made less noticeable. To achieve this we will use the smudge tool as seen in 

Fig 3.3. 

We will use this tool to blend the black and red 

so as that they are not so noticeably contrasted. 

We must choose a suitable brush size for this, 

and as this will be a delicate enough task, we 

will 

use a small brush, of size 3, so that we have better control over the area affected. 

Also feel free to increase the magnification further if this helps you see more of the 

area we are manipulating. So, making sure the redeye fill layer is active, begin 

smudging the black area outwards to mask and mingle with the remaining red areas. 

Do not smudge over the few white pixels remaining in the centre of the pupil, as 

these will help the 

image retain a more natural look 

when finished. 

When you’re finished smudging, 

reduce the magnification to 100% 

again so that you can see the 

result. Notice the difference already 

between the eye that has been 

Fig 3.2 

Fig 3.3 

Fig 3.4 
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edited and the one that hasn’t. There is a marked improvement. 

When working within such a finite space as the pupil of the eye, it is quite possible 

that you will make mistakes. To undo one single mistake, you can use the keyboard 

shortcut ctrl + z. However, if you wish to undo a whole series of commands, it is best 

to use the History palette. This contains a record of a significant proportion of the 

last number of commands that you have made, be it opening the image, selecting 

a 

particular tool or even using a particular 

tool, as we can see in Fig 3.5. 

It is also worth noting that if you want 

to completely undo all changes you 

have made to a Photoshop document, 

you can use the Revert command, 

under the file menu, which will revert 

the image to the previous saved version of it. Make sure you want to be rid of all 

changes though, or you could loose a full days work. 

Getting back to the task at hand, repeat the steps that you followed for the first eye to 

remove the red in the second eye. You should be saving your image the whole time 

as you go along. Then, when you are satisfied that you have removed enough of the 

red eye, save the image as a JPEG image called redeye_filled.jpg. You can see the 

difference between the before and after below in Fig 3.6. 

  

Before After 

Fig 3.6 

Fig 3.5 
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Brightening a Photograph: 

In the photo that we have used for the red-eye example, you will notice that the 

image is quite dark. Photoshop provides facilities for brightening images that are too 

dark. 

Open the redeye_filled image in 

Photoshop. Go to the Image menu and 

select Brightness/Contrast from the 

Adjustments sub-menu. For the 

purposes of this example, we have 

increased the brightness to 30 and the contrast also to 30. Make sure the preview 

option is checked so that you can see the changes to the image before you click OK. 

If you had just increased the brightness, you may find that, although brighter, the 

figure in the picture also looked paler. By increasing the contrast as well you maintain 

the brightness/contrast balance. When you are finished click Save As under the file 

menu (do not click save as you may want to retain a copy of the image as it was 

before you made the changes to the brightness and contrast). Save the file as 

Brightness_Example.jpg within the PSImages folder. Fig 3.8 shows the result. 

  

Before After 

Fig 3.8 

 

Fig 3.7 
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Cleaning Up a Digital Photograph: 

In this section we will look at cleaning up digital photographs. We will look at how to 

remove blemishes from an image and replace them with more sightly aspects of 

the 
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image. This technique is sometimes known as “airbrushing” and is used quite widely 

in the fashion industry where models faces are “touched up” digitally before 

publication. In our example, however, we will be touching up an image of UCC’s 

grounds and not any famous models! 

 
In your PSImages folder, you will find a picture called ucclitter. Make a copy of this 

image and call it ucclitter_example. It is this copy that you will be working from. 

Open this picture and as we did for the red-eye reduction, we copy the entire image 

to a new layer. The picture is of the lower grounds of UCC by the river. As we can 

see there is some unsightly litter in the picture, which we would like to remove so that 

the picture could be used in promotional literature. 

To do this we use the clone stamp tool. Its operation is simple enough 

– you press the alt key and click on the area that you want to copy from and 

then left click the area you want to copy to. Before we start the cloning 

process, we must choose a suitable brush size. The smaller the area you 

are cloning to, the smaller the brush should be. And although this is quite a 

simple process, it can be quite delicate so remember to use your history 

palette if you 

make mistakes. 

The first area we will clone from is the darker green area below the small piece of 

white rubbish by the edge of the river. We will use this green area to cover the 

rubbish. Use a brush size of 3 for this. Again, feel free to zoom in, in order to have a 

greater view of the area you are working with. Select the area to clone from by 

pressing ALT and clicking. Then paint over the white rubbish. The result can be seen 

below in Fig 3.10. 

  

Before After 

Fig 3.10 

 

 
For the other larger pieces of rubbish, choose a larger brush of size 19. Select an 

area to the left of the black bag to copy from. Give your self plenty of room to 

manoeuvre 
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or you could end up copying from where you want to copy to – meaning that you will 

just redraw the rubbish in a different place. We see the result in Fig 3.11 below. 

  

Before After 

Fig 3.11 

 
 

Image Resizing: 

When working with digital photographs, it is often necessary to resize them to more 

manageable sizes in order to print them or to use them on the web. On the web, 

the use of thumbnail pictures is common place where by a large number of pictures 

need to be displayed but where the site owner does not wish to overburden their 

server or the user’s connection with large images. In these cases, the thumbnail 

would act as a link to a separate page containing the image. 

To produce a thumbnail image is very 

simple. Under the Image menu select the 

Image Size option. The Image Size dialogue 

box will then be presented, allowing you to 

resize the image to suit your purposes. If 

you wish to retain the ratio between height 

and width, keep the Constrain Proportions 

box checked. You can also specify the 

dimensions as percentage of the original size and can change the resolution for 

printing purposes too. 
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